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Working with Census Data to Calculate Social Vulnerability  
Introduction 

The Social Vulnerability Index (SoVI or SVI), developed by Cutter et al. 2003, uses a 
variety of county-level socioeconomic and demographic indicators to construct an 
index of social vulnerability to natural hazards. The Center for Disease Control (CDC) 
describes social vulnerability as “the potential negative effects on communities caused 
by external stresses on human health.” Relying on data collected by the U.S. Census 
Bureau, the SVI is a useful tool that helps to identify geographical variation of social 
vulnerability across communities and subsequently inform stakeholders where the need 
is greatest. 

Social vulnerability analyses include an array of population characteristics to calculate 
a vulnerability score; metrics often consist of income status, race and ethnicity, age, 
gender, residential property (value/quality), renters/homeowners, employment loss, 
social dependence, education, occupation, rural/urban, family structure, access to 
medical services, population size, and special needs populations. As the occurrence of 
climatic extremes, such as flooding, and prolonged drought are expected to increase, 
assessing social vulnerability is crucial to disaster preparedness.  

Nonprofits and community-based organizations working to address disparities of 
disinvestment, marginalization, high poverty, and vulnerability in their communities can 
utilize the SVI to not only better understand local population characteristics, but also 
make stronger cases for targeted investments that advance a community’s ability to 
prepare for, respond to, and recover from environmental hazards. The following guide 
outlines steps needed to carry out an abbreviated version of a social vulnerability 
analysis of counties in Kentucky. 

Objectives:  

• Source and download ACS data from the U.S. Census Bureau  
• Format ACS data using Microsoft Excel  
• Perform calculations in Excel to identify and rank social vulnerability index scores 
• Create two maps comparing resulting SVI scores and percentile ranks for all 

counties in Kentucky 

VIDEO TUTORIAL LINK (to come) 

 

Getting started 

DOWNLOADING & VIEWING DATA FROM THE CENSUS BUREAU  

1. The U.S. Census Bureau serves as one of the leading publicly available sources of 
up-to-date, quality data about its people, places and economy. Available 
datasets include the Decennial Census, which occurs every 10 years, and the 

https://www.jstor.org/stable/42955868
https://www.atsdr.cdc.gov/placeandhealth/svi/index.html
https://data.census.gov/cedsci/
https://data.census.gov/cedsci/
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ongoing American Community Survey offered at 1-, 3- and 5-year intervals 
beginning in 2000. While the Decennial Census data is the most dependable, 
ACS data offers reliable and timely insight into changing social, economic, 
housing and demographic characteristics.  

2. Using ACS data, we will loosely follow methods employed by the CDC to 
represent characteristics of socially vulnerable populations: age 65 or older, 
minority or race, income level, and educational attainment, and determine SVI 
scores.  

3. To begin, open the browser and navigate to the Census Bureau’s data portal: 
https://data.census.gov/cedsci/  

4. Select Advanced Search then click Geography. 
 

 
 

5. The American Community Survey provide a diverse collection of tables and 
profiles that are categorized by subject or topics and cover specific geographic 
areas. We need to filter the ACS data by topic to extract the correct tables (For 
more detailed information on ACS data tables and products visit the Census 
Bureau ACS Data Tables page).  

6. To apply the desired filters, select County, then Kentucky. Next select All Counties 
within Kentucky. Under the Years tab, select 2019.  

7. Navigate to the search bar at the top of the page and type in DP03, click 
search. The letters D & P stand for Data Profile, meaning it contains summary 
statistics on a specific subject profile, e.g. economic, housing, etc.  

8. The data profile Selected Economic Characteristics should populate. We will use 
this table to extract a few socioeconomic measures. (NOTE: Near the top, toggle 
between tables and maps to view different variables and explore what is 
contained within the table or visualize them in a map.) 

https://www.census.gov/content/dam/Census/library/publications/2020/acs/acs_general_handbook_2020_ch09.pdf
https://www.epa.gov/system/files/documents/2021-09/climate-vulnerability_september-2021_508.pdf
https://data.census.gov/cedsci/
https://www.census.gov/programs-surveys/acs/data/data-tables.html
https://www.census.gov/programs-surveys/acs/data/data-tables.html
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9. You’ll notice there are two tables available for download: ACS 1-year Estimate 
and 5-year Estimate. We want to select and download the ACS 5-year Estimate 
table (as a CSV) for year 2019 only. We use the 5-year estimates because they 
include accumulated data for all years 2015-2019, therefore smaller geographic 
areas are more accurately captured and the margin of error is reduced.   

10. Now we need to download some demographic data to include in the social 
vulnerability calculation. Return to the search bar and type in DP05. 

 

 
11. The ACS Housing and Demographic Estimates table should appear below. Make 

sure to select the 2019 5-year Estimate then click Download CSV.  
12. Return to the search bar and type in S1501 – Educational Attainment.  The S 

classification indicates to the user that this is a subject table. Subject tables vary 
only slightly from data profiles where subject tables contain summary statistics by 
topic, e.g. employment, education, and income.  

13. You’ll want to ensure the filters we applied earlier (Year 2019, All Counties in 
Kentucky) have not changed so that all our variables align temporally and 
geographically. Remember to download the 2019 ACS 5-year Estimate table 
only. 

Data Processing  

FORMAT COLUMNS IN EXCEL 

14. Now that we have the files we need, we need to set up a storage system for our 
data. We’ll start by extracting our files to a new folder. We will format the data in 
Microsoft Excel for analysis later.  

15. Open the file explorer  on your computer. Create a new project folder 
where you will save all files. Name the folder SVI, then within that folder create a 
new folder and save it as ACS_Data. Begin extracting the contents of the zip files 
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into this data folder. (NOTE: If any errors occur, delete the files from the data 
folder and retry the extraction).   

16. Once all files have been unzipped, you should see a total of 9 files in your data 
folder. Note the file names and type (file extension). Each file name indicates 
what is contained within (profile or subject), the source (ACS) and the year 
(2019).   

17. For each table we downloaded, DP03, DP05, and S1501, there are three 
corresponding documents: a .txt file, a metadata.csv file and a data.csv file. The 
text and metadata files are provided by the Census Bureau to assist user 
navigations of the data; together, they provide detailed documentation on 
data definitions, methodology, design and limitations (NOTE: Visit Understanding 
and Using American Community Survey Data: What All Data Users Need to Know 
to learn more about how to use ACS data).  

18. First, open a new Blank Workbook. Next, open the ACSDP5Y2019.DP05-Data file. 
We are going to copy and paste only the metrics we need into the new 
workbook.  

19.  Select the GEO_ID and NAME column (column A & B) to right-click →  copy & 
paste into the new workbook (cell A1). The Census Bureau uses numeric ID codes 
called GEOID’s to uniquely identify all administrative/legal, and statistical 
geographic areas for the tabulated data.  

20. Recall that the DP05 table contains estimates on demographic characteristics. 
We will use this table to obtain the demographic variables relevant to our 
vulnerability analysis.  

21. Return to the data folder and open the ACSDP5Y2019.DP05-Column-Metadata 
file. The metadata file contains information about each variable; notice how 
there is an estimate, percent, and margin of error column for each one. The 
margin of error describes the +/- error of the estimate, while the estimates 
contain the data we need.  

22. In the metadata file, use Control + F to search for the following: 
a. “Percent!! SEX AND AGE!! Total population” 
b. “Percent!!SEX AND AGE!!Total population!!Female” 
c. “Percent!!SEX AND AGE!!Total population!!Under 18 years”  
d. “Percent!!SEX AND AGE!!Total population!!65 years and over” 
e. Percent!!RACE!!Total population!!One race!!Black or African American” 
f. “Percent!!HISPANIC OR LATINO AND RACE!!Total population!!Hispanic or 

Latino (of any race)” 
23. For each variable note the column names (DP05_0001E, DP05_0003PE, 

DP05_0019PE, DP05_0024PE, DP05_0038PE & DP05_0071PE respectively). 
24. Return to the DP05 data table and use Control + F to locate each variable using 

the column names we just obtained. Copy & paste each variable into the new 
worksheet.  

25. Make sure to hit save. Name the file SVI_DATA and save the new file in the SVI 
folder as a .csv NOT a .xslx file. Go ahead and close the DP05 data table and 

https://www.census.gov/programs-surveys/acs/library/handbooks/general.html
https://www.census.gov/programs-surveys/acs/library/handbooks/general.html
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metadata files. Open the ACSDP5Y2019.DP03-Data and ACSDP5Y2019.DP03-
Column-Metadata files. 

26. The Census Bureau classifies the total number of people in poverty as the sum of 
all people in families and the number of unrelated individuals with incomes in the 
last 12 months below the corresponding poverty threshold.  

27. Following the same methods found in steps 22-25, we need to find the 
percentage of all people whose income in past 12 months is below the poverty 
level as one measure of socioeconomic status.  

28. As an additional socioeconomic indicator of vulnerability, we’ll also include 
unemployment rates for all counties. In the metadata file, use Control + F to filter 
for “unemployment rate.” Using the column name (DP03_0009PE) copy & paste 
the variable into the workbook.  

29. Next, open the ACSST5Y2019.SI501-Data and ACSST5Y2019.SI501-Column-
Metadata tables. The final measure of social vulnerability that we need to 
include is educational attainment. In the metadata file, sort & filter 
“Estimate!!Percent!!AGE BY EDUCATIONAL ATTAINMENT!!Population 25 years and 
over!!9th to 12th grade, no diploma”  

30. We have gathered a total of 8 measures for our social vulnerability assessment. 
Depending on the purpose of the SVI assessment, certain metrics are more 
important to include. For example, this guide focuses on social indicators of 
vulnerable populations, but we could further extend the assessment to include 
other themes of social vulnerability. Other themes of social vulnerability range 
from housing, transportation, and access to a vehicle, to household composition 
English as a second language, and disability.   

31. We still need to format columns and rename variables.  
 
 
Start by renaming: 
 
a. GEO_ID → GEOID 
b. NAME →  County 
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32. For each of the rest of the columns, change the label to the following so we can 
better identify them: 

c. DP05_0001E → TOTALPOP 
d. DP05_0003PE →  FEMALE 
e. DP05_0019PE →  UNDER18 
f. DP05_0024PE →  OVER65 
g. DP05_0038PE →  BLACK 
h. DP05_0071PE →  HISPANIC 
i. DP03_0128PE → POVERTY 
j. DP03_0009PE →  UNEMPLOYMENT 
k. S1501_C02_008E →  NODIPLOMA 

 
33. Remove the second row from the table. Highlight row 2 →  right-click →  delete.  
34. Right-click column B →  insert column. Ensure that column B (County) is selected. 

In the ribbon at the top select Data →  Text to Columns →  Delimited as the file 
type and hit Next.  

35. In the following window select Comma as the delimiter ONLY. Hit Next →  Finish. 
Notice how ‘Kentucky’ now has its own column; go ahead and label the column 
STATE. Refer to the example provided to ensure there are no errors.  

Social Vulnerability Assessment 

CALCULATE INDICES TO PRODUCE FINAL MAP 

36. The final composite social vulnerability index score is generated using an 
additive model relying on no a priori assumptions about the importance of each 
variable. In other words, assuming equal importance of each variable, an SVI 
score is the unweighted sum of all variables. Because it is based on estimates, 
the SVI score is only a relative measure of overall social vulnerability and cannot 
be interpreted as absolute. 

37. Return to the Excel SVI spreadsheet. To calculate the social vulnerability score, 
add a new column to your table named SVISCORE. In the cell below (m2) type in 
the following formula: 

a.  =SUM(E2, F2, G2, H2, I2, J2, K2, L2) (NOTE: We included total population to 
allow for comparisons later, but it is not included in the SVI calculation.)  

b. Hover the cursor over the corner of the cell. The cursor should change into 
a white crosshair; double-click [or click and drag to end of column] to 
populate scores for the remainder of the column.  

c. Highlight the entire column → copy & paste values into the same column. 
This step ensures that values are stored in the cell, instead of the formula.  

38. SVI scores are unitless values, e.g. there is no associated unit of measurement. 
Nonetheless, variables used in this guide are scaled to where higher values 
indicate increased social vulnerability, and lower values indicate decreased 
social vulnerability.  
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39. Under the Data tab, activate the Filter  function for all fields. Under SVISCORE, 
sort from largest to smallest.  

40. The county that received the highest SVI score is Fulton, followed by Harlan and 
Wolfe County. Instead of simply tabulating or mapping SVI scores, we are going 
to determine a percentile rank of SVI scores to determine the proportion of 
counties with high social vulnerability relative to counties with low social 
vulnerability. By doing this, we can also compare social vulnerability in each 
county relative to all of Kentucky.   

41. A percentile rank indicates the percentage of counties that are at or below a 
particular rank score. We want to know which counties are at or below the 
highest SVI index score (168.3). 

42. In the next column, type in PERCENTRANKSVI (make sure that the filter function is 
applied to this column). In the cell below (N2) type in the following formula:  

a. =RANK.EQ(M2, $M$2:$M$122,1)/COUNT($M$2:$M$122) (NOTE: Do not 
attempt to copy and paste the formula into Excel. This will result in simple 
errors that can compromise the final SVI rank scores). 

b. Repeat hovering the cursor over the cell corner to populate the rest of the 
percentile ranks.  

c.  
d. Highlight PERCENTRANKSI (column N). In the ribbon, under the Home tab 

→  Number →  General.  These values still represent percentages, but 
using the General classification allows the user to input values in the 
desired format without errors, e.g. Excel will store values how they’re- 
entered.  
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43. The resulting percentages thus reveal the magnitude of social vulnerability in 
each county relative to the SVI score of Fulton County (the most socially 
vulnerable, according to our SVI score).  

44. Using the Filter function →  sort the data from A to Z using the COUNTY column.  
45. Scroll down to row 61; notice this row includes estimates for all of Kentucky, not 

one particular county. Copy the entire row and paste again as the last row. 
Delete row 61. 

46. NOTE: SVI index score and percentile ranks can be calculated directly in ArcGIS 
Pro, however, the user is limited to the version of ArcGIS Pro and available tools. 
Therefore, for our purposes, calculating the SVI score and percentile ranks in 
Excel was sufficient.   

47. We can create some rudimentary maps using Microsoft Excel because we 
already have the required geographic data included in the dataset.  

48. Using CTRL + Shift, select COUNTY & STATE (Column B & C) and SVI_SCORE 
(Column M). In the ribbon, select Insert →  Recommended Charts →  select Map. 

 

 

49. Change the map title to Social Vulnerability in Kentucky, 2019. To edit map 
properties, right-click → the specific element you want to edit to open the 
properties window pane on the right.  

50. We want to change the legend position, map color scheme, as well as the 
classification. Right-click Map →  Format Data Series →  Series Color →  select 
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Diverging (3-color). Change the Minimum color to blue, Midpoint to pale yellow, 
and Maximum to red. Leave the defaults as lowest value, midpoint, & highest 
value.  

 

 

 

 

 

 

 
 
 
 
 
 
 
 

51. Next, right-click legend → Position → Top. Spend some time in the properties 
pane editing labels, border outline width and color until you are satisfied with the 
map.  

52. Repeat steps 49-52 to create another map of percentile ranks. Using CTRL + Shift, 
select COUNTY & STATE (Column B & C) and PERCENTRANKSVI. In the ribbon, 
select Insert →  Recommended Charts →  select Map. Edit map properties.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Values closer to 1 
indicate high social 
vulnerability. Values 
closer to zero indicate 
decreased social 
vulnerability.  
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53. While the maps on their own provide a lot of information about social 
vulnerability in Kentucky, it is recommended to develop a supplementary table 
of descriptive statistics that offer additional insights into population 
characteristics.  

54. Recall that we included estimated count of total population for each county in 
Kentucky. All other estimates for each metric are represented as a percentage. 
To enhance final maps, create a table displaying overall social vulnerability in 
Kentucky, as well as population characteristics in the most socially vulnerable 
counties (Fulton, Harlan, Wolfe). You can also include population breakdowns of 
the top 3 least socially vulnerable to better identify where gaps exist.  

**If you wish to complete the optional ArcGIS Pro portion of this tutorial, it is recommended that 
you create a copy of the SVI.csv to work with in the software to avoid errors. ArcGIS Pro can only 
read single-sheet CSV files and cannot process the maps you create in the workbook.  

 

Census Bureau TIGER Files (OPTIONAL) 

SOURCING GEOGRAPHIC DATA 

55. The following steps are an OPTIONAL addition to the guide and are not required 
to calculate SVI.   

56. Social vulnerability assessments serve as key screening measures of how well a 
community may respond to external disruptions or stressors that negatively 
impact human health and economic well-being. It is often helpful to include a 
map displaying the geographic distribution of the final SVI score to supplement 
tabulated results.  

57. To download a shapefile of the U.S. visit the Census Bureau’s TIGER/Line website. 
Select Web Interface .  

 

 

 

 

 

 

 

 

 

 

https://www.census.gov/geographies/mapping-files/time-series/geo/tiger-line-file.html
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58. Next, for the year, select “2019”, for layer type click the drop-down to select 
Counties (and equivalent) then click submit to download national file (To learn 
more about shapefiles, coverages their applications visit ESRI ArcGIS online and 
Census Bureau). 

59. A file named tl_2019_us_county should appear. In the SVI folder you created 
earlier, create a new folder and name it TIGER. Begin extracting the TIGER/Line 
zipped file into this folder.   

60. Open ArcGIS Pro. Create a New Project and name is SVI. Save it in the project 
folder (SVI) that we’ve been working in thus far. Uncheck Create a new folder for 
this project box.  

 

61. In the Catalog Pane click the Folder drop-down and select (click and drag) the 
geographic shapefile tl_2019_us_county.shp stored in the TIGER folder. 
Additionally, go ahead open the SVI.csv file. If you don’t see your data, right-
click Folders → Add Folder Connection → select SVI folder. (NOTE: If you are 
unable to open the spreadsheet in ArcPro, ensure that the file is saved as a CSV 
and NOT a workbook (.xslx); refresh folder connection and try again).  

62. We’ll start by using Select by Attribute to filter out counties in Kentucky. Open the 
attribute table for the U.S. shapefile, right-click feature layer →  open attribute 
table. We’ll use the STATEFP attribute to select all counties in Kentucky. In the 
Select by Attributes window plug in ‘Where ‘STATEFP’ is equal to 21’ and click OK.  

63. The selection should now be highlighted in blue. You will need to export the 
newly selected attributes to a new feature layer, right-click 
tl_2019_us_county.shp → Data →  Export Features. Name the file Kentucky and 
save it in the SVI.gdb. 

https://doc.arcgis.com/en/arcgis-online/reference/shapefiles.htm
https://www.census.gov/programs-surveys/geography/technical-documentation/complete-technical-documentation/file-availability.html
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64. In order to map our SVI scores, we need to join our table data to the geographic 
shapefile. Open the attribute table for SVI.csv and the new Kentucky.shp layer. 
To join data in ArcGIS Pro there must be a common key between tables. Take a 
look at what is contained within each attribute table—column labels can be 
different, but the attribute must be the same type, e.g. text OR numeric. It looks 
like we can use COUNTY and NAMESLAD as the common key for our join. 

 

65. Order matters when joining data. We need to append the SVI.csv to our 
geographic shapefile. To do so, right-click Kentucky.shp →  Joins and Relates → 
Add Join. Click Run. Refer to the example to check for errors.  

66. Check to see if the join worked by looking at the attribute table. All fields from 
the SVI.csv should be appended to the shapefile. Export the newly joined data 
as Kentucky_svi. Make sure to save in SVI.gdb.  

67. Lastly, right-click Kentucky.shp → Joins and Relates →  Remove All Joins. Remove 
Kentucky.shp from the table of contents. 

68. Let’s edit Symbology to display SVI scores. Right-click Kentucky_svi.shp → 
Symbology. A new window will appear on the right. Under Primary Symbology → 
Graduated Colors.  

a. Field: SVISCORE 
b. Normalization: None 
c. Method: Standard Deviation 
d. Interval Size: 1 standard deviation 
e. Classes: Default (6 classes) 

69. Change the color scheme to a diverging (discrete) color 
ramp. You can use any color range, but be sure to choose a scheme that can 
easily distinguish high and low values. (HINT: To reverse symbol order, below 
Classes right-click Symbol →  reverse symbol order to adjust the color ramp).  
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70. Under Label, change the label names to Low, Low-Moderate, Moderate, 
Moderate-High, High, Extremely-High.  

71. To complement the SVI map, you can copy & paste the feature layer to a New 
Map. In the ribbon under Insert → New Map, paste the map here. Now, change 
the symbology to the percentile ranks attribute we manually calculated in Excel. 
Change Method →  Quantile. Leave the number of classes (5).  

72. Do not close the symbology window. Go to the Advanced Symbology  tab, 
then click the Format Labels dropdown →  change the Category to Percentage 
→  next to Percentage select Number represents a fraction, adjust it to show as a 
percentage. Lastly, under Rounding → change the number of decimal places to 
0. (HINT: Change the classification method to see how it changes the map. To 
learn more about classification methods visit ESRI: Data Classification Methods). 

73. Return to Primary Symbology. Select a new color scheme different from the one 
used to represent SVI scores. Remember you can reverse symbol order so that 
darker colors represent high vulnerability and lighter colors represent low 
vulnerability (right-click Symbol →  reverse symbol order).  

74. Change Labels to the following: <20%, 20%-40%, 40%-60%, 60%-80%, >80%. 
75. The last step is to create an inset map. Inset maps are a useful tool that provide 

geographical context to an audience. Return to the ribbon, Insert → New Map. 
Open the Catalog Pane → add tl_2019_us_county.shp and Kentucky.shp to the 
workspace.  

76. Open the ArcToolbox   (also known as geoprocessing pane). Search for 
Dissolve →  Input Features: tl_2019_us_county.shp →  Output Feature Class: 
US_dissolve →  Dissolve Field: STATEFP. Change the Symbol color to a light gray.  

77. Repeat the last step for the Kentucky.shp file using the Dissolve tool. Change to 
Symbol color to another neutral color. A dark gray, or pale yellow should work.  

Creating Final Maps 

 ADDING CARTOGRAPHIC ELEMENTS 

78. Now we are ready to produce a final map. Return to the ribbon, select Insert → 
New Layout →  Landscape - Letter 8.5” x 11”. Then, import each Map Frame to 
the layout and begin adding map elements.   

79. Once you select the Map Frame, a crosshair cursor will appear when you hover 
over the page. Click and drag the frame to adjust the size to where the margins 
are equal, but ensuring that both maps can easily fit.  

80. You can further adjust the positioning of the map itself by activating the map 
frame. In the Contents, right-click Map Frame > Activate. To exit simply click Back 

to Layout at the top.  Make sure to leave ample space to 
add in cartographic elements, such as, a scale bar, North arrow, and legend.  

https://pro.arcgis.com/en/pro-app/2.8/help/mapping/layer-properties/data-classification-methods.htm
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81. In the ribbon, under the Insert tab, the Map Surrounds box contains all the 
elements you will need to make the final map. Click each element one at a time 
then click the cursor in the white space to add each element.  

82. To edit map elements, right-click on the element > properties. Alternatively, you 
may double-click the desired element in the Contents to open its properties. In 
the window on the right you can modify text fonts and size, labels, and 
placement and positioning of all the map elements. (NOTE: For additional 
information on formatting map elements visit ESRI: Layouts and Map Surrounds to 
learn more).  

83. Add a title for the map, in addition to a simple reference title for both maps to 
inform the audience of map content. To add a title, click Straight Text and then 
click and drag the cursor to insert the text box. Name the map “Social 
Vulnerability in Kentucky, 2019.” 

84. Add the last Map Frame that you’ll use for the inset map.  
85. Remember to add a citation for the data, (e.g. U.S. Census Bureau ACS 5-year 

Estimates 2015-2019) and your name as the author.  
86. Finally, to export map navigate to the ribbon and select Share > Export Layout. 

On the right export the map as a PNG file. PNG is the recommended file type for 
exported GIS products that may need to be shared online or inserted in other 
documents because it preserves text and lines best. Name the output 
SVI_final_map and make sure to save in your project folder. The final map should 
look similar to the example provided.  

87. Compare results to the CDC’s SVI map. 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://pro.arcgis.com/en/pro-app/2.8/help/layouts/add-a-legend.htm
https://svi.cdc.gov/map.html
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**Disclaimer: All data used in this tutorial was obtained from the U.S. Census Bureau. Analysis 
methods were loosely modeled using the CDC SVI methodology. No measures were taken to 
account for high margins of error. It is common for smaller geographic and rural areas to have 
higher margins of errors due to smaller sample sizes, but for publication purposes, the author 
encourages users to account for high margins of error and include additional resources to 
complete a comprehensive social vulnerability analysis.  

 

Limitations to consider: 

The social vulnerability index is used by a variety of local and federal government agencies, 
public health officials, planners, emergency responders, and academics as a planning tool to 
evaluate a community’s ability to respond to environmental hazards. Drawing together from a 
range of socioeconomic, demographic, and housing/transportation measures, the SoVI score 
illuminates not only geographical variation of vulnerability, but also unearths the type of support 
needed to reduce impacts related to both natural- and human-caused disturbances. 
Nonetheless, the use of SoVI assessments are inherently subjective and are typically conducted 
for a specific purpose. It is therefore important to understand that SoVI scores are only a relative 
measure of social vulnerability, and are only as accurate as the data used to calculate SoVI 
scores. For example, SoVI scores for a particular region can change depending on the measures 
used to characterize vulnerable populations, as well as the importance placed on such 
measures. It is increasingly recognized that local assessments of social vulnerability are more 
reliable and future assessments should consider involving local experts and available data to 
support future planning.  

Sources 

American Community Survey Data Tables 

American Community Survey & Puerto Rico Community Survey: Subject Definitions  

CDC/ATSDR SVI Fact Sheet 

Climate Change and Social Vulnerability in the United States 

Community Based Vulnerability Assessment 

Methods for CDC Social Vulnerability Index 

Practical Guide to the SVI 

Ultimate Guide to using Excel 

Understanding and Using American Community Survey Data: What All Users Need to 
Know 

United States Census Bureau: American Community Survey 

 

https://www.census.gov/programs-surveys/acs/data/data-tables.html
https://www2.census.gov/programs-surveys/acs/tech_docs/subject_definitions/2020_ACSSubjectDefinitions.pdf
https://www.atsdr.cdc.gov/placeandhealth/svi/fact_sheet/fact_sheet.html
https://www.epa.gov/system/files/documents/2021-09/climate-vulnerability_september-2021_508.pdf
https://www.mdcinc.org/wp-content/uploads/2017/11/Community-Based-Vulnerability-Assessment.pdf
https://www.youtube.com/watch?v=REKFHOryflA
http://www.inckmarks.org/docs/newresources/PRACTICALGUIDEFORSVI.pdf
https://blog.hubspot.com/marketing/microsoft-excel
https://www.census.gov/programs-surveys/acs/library/handbooks/general.html
https://www.census.gov/programs-surveys/acs/library/handbooks/general.html
https://data.census.gov/cedsci/



